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Conventions
The following conventions are used in this manual:
»

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.
This icon denotes a tip, which alerts you to advisory information.
This icon denotes a note, which alerts you to important information.

bold

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options.

italic

Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.
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Introduction to the Adaptive
Trade Management System

1

The Adaptive Trade Management System (ATM) was created by OmniTraders
International, LLC (OTI) to develop an advanced trade management feature for the
OmniVest Platform. In order to implement the feature as quickly as possible, the
OmniTrader software was used to develop the first version.
There are 3 Key Benefits to this approach. Having ATM in OmniTrader enables us to
easily experiment with advanced concepts. OmniTrader users who purchase a license
to ATM from OTI are able to use the product in OmniTrader while it is being
purposed for OmniVest. Finally, ATM license holders will be able to use ATM in
OmniVest when it is available there.

Installing ATM
Before you can begin using ATM, confirm that you have the latest version of
OmniTrader installed. Then, follow these instructions to install ATM:
1. ATM can be installed from the following link:
http://www.omnitrader.com/currentclients/downloads/item.asp?Prodcode=3831
2. Follow the instructions that appear in the installation wizard dialog boxes.

Registering ATM
Before you can use ATM, you must register it.
1. Click Help»Registration.
2. Enter the ATM CD key provided on your invoice or click Get My CD Keys.
3. Restart OmniTrader to activate the new registration key.

© Nirvana Systems Inc.
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The ATM Components
ATM contains the following components:
• ATM Universal Method
• ATM Profile
• ATM Toolbar (formerly ATS)
• Four ATM Focus List Columns
• ATM Chart Template
• ATM Auto Trend Profile
• ATM Auto Trend Method
• ATM3 LT Trend Strategy
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Getting Started with ATM

The ATM Profile is pre-configured with all of the settings enabled to duplicate the
results that were advertised in the ATM sales material. To access the ATM Profile go
to the OmniTrader file menu and click File››Open, select the Profile from the list and
click Open again.
In order to duplicate the results exactly, you must own all of the plugins that provide
the seven enabled strategies. It is not, however, necessary to own these additional
plugins to make use of ATM. Any strategies can be used with the ATM system.

Add the ATM Toolbar to OmniTrader
In order to get started with ATM, add the toolbar to OmniTrader. If you were
previously using ATS in OmniTrader, the ATS toolbar will automatically be
converted to ATM and it will not need to be added. If not, follow these instructions to
add the toolbar:
1. Click View››Toolbars.
2. Click the check box next to “Adaptive Trade Management” near the top.
3. Move the toolbar by dragging its edge to the tool bar area and releasing.

Figure 2-1. Adding the ATM Toolbar to OmniTrader
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Activate the ATM Methods
The ATM Profile is pre-configured with these methods enabled, however, the method
can be activated in any profile by following these instructions:
1. Activate the ATM Methods dialog List by clicking the ATM tool bar.
2. Select % of Equity by clicking the check box under the Enabled column.
3. Select Universal (from ATM) at the bottom under the Default column

Figure 2-2. Enabling % of Equity and Universal

Review the Portfolio Simulator Results
Data, analysis and the Portfolio Simulation must be updated in order to view results.
1. Run the ToDo List by clicking Run Selected Tasks. Each task that is not up to
date will be automatically selected.
2. Once the data and analysis updating is complete, click Mode››Portfolio
Simulator.
3. Click Run Analysis.
4. Click the “% of Equity” or “Universal” tabs to see performance.
5. Click Summary to see a comparison.
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Figure 2-3. Portfolio Simulator Summary Tab (with Log Scale Off)

In the above example, Universal is so much more profitable than % of
Equity that you can hardly see the % of Equity Curve. Open Chart Options
and enable “Lograthmic Price Scale”.
Note
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5

Adaptive Trade Management User Guide

3

Trading with ATM

The ATM System is designed to be traded automatically. In order for the system to
trade automatically, certain configuration settings need to be made.

Activating AutoTrade
1. If you are in Portfolio Simulation Mode go to Real Mode by clicking
Mode››Real.
2. Click View››Toolbars.
3. Activate the AutoTrade Tool bar and drag it to the tool bar area..

Figure 3-1. Adding the AutoTrade Toolbar to OmniTrader

Before you can use AutoTrade, you must establish an email account
to receive important notifications. Click Tools››Options and on the General
tab establish and test your email settings. If you need assistance with this,
please call support at 1-512-345-2545..
Note
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Figure 3-2. Enabling an Email Address for Notifications

4. Click the AutoTrade toolbar to activate the AutoTrade feature.
.

Figure 3-3. Configuring AutoTrade

5. Set Max Percent Equity to the percent of your account you want AutoTrade to
manage. If you have a “cash” account (like an IRA) then the most you can use is
100%. If you have a margin account, the most you can use is 200%. Remember,
© Nirvana Systems Inc.
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the actual per-trade allocation is handled in the Allocation tab of ATM, so if you
are trading less than 100% of your account, be sure to check these settings to make
sure trade size is not more than Max Percent Equity.
6. Select (o) Method and then “Universal” in the drop down box.
7. Optionally, select the Round to requirement (typical value is 100).
8. DO NOT CHECK the option to Close Positions on Exit Signal when using an
ATM Method
9. EOD Trade Settings:
• Run ToDo List—The time automation will be run each day.
• Submit Orders—The time orders will be submitted OR submit orders
when the ToDo List completes. With some brokers, orders must be
submitted just before the Open. With others, they can be submitted any
time. See Note 2 below about mixed order types in Strategies.
• Update Portfolio—Current positions are updated in the Portfolio with a
2nd run of the ToDo List. An additional run will cause data and analysis
to be updated, which can trigger trade plan exits to be executed early. This
option is not recommended for AutoTrading with ATM as it can cause
differences in your trades from the Universal method.
10. Check the AutoTrade checkbox to enable AutoTrade.

Figure 3-4.

When AutoTrade is active, the AutoTrade tool will turn GREEN

AutoTrade will run the ToDo List at the Run ToDo List time, submit trades at the
Submit Orders time and (optionally) update the Portfolio with current positions at
the update Portfolio time.

Adaptive Trade Management User Guide
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Focus List Columns
There are several new columns for the Focus List that support ATM.Columns can be
added to the Focus List using the Wrench Icon.

Figure 3-5. The Wrench Icon on the Focus List

Figure 3-6. Configure Columns
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The ATM Columns are as follows:
• AT—Displays if a Position is taken by ATM.
• ATPos—Displays either ▲ or ▼ to indicate Trade direction.
• ATS—AT Sort (Rank) column, normalized on a scale from 0 to 100.
• ATShrs—Displays # of Shares taken in the trade.
• ATStrategy—The Strategy ATM entered on. IMPORTANT: This will usually
NOT match what the Focus List shows in the Strategy column. This is because
ATM uses Market State to select Strategies for trading whereas the Strategy
column shows Strategies from the Vote Line.

Daily Automation Runs
Each day, your ToDo List will run at the appointed time. ATM adjusts the Ranking
method and Allocation approaches based on Market State. At the end of this process,
it will arrive at a specific list of trades to take. These trades are indicated by a check
in the AT column.
Trades initiated by AutoTrade can be closed using the “C” icon in the upper right of
the chart.
Additional trades can be placed in OmniTrader manually, but these trades may
conflict with ones that AutoTrade is attempting to place. An order cannot be
submitted by any means for a security if there is an existing order or position open for
it.
AutoTrade can be turned ON or OFF at any time. If AutoTrade is turned OFF and then
ON, trades initiated by AutoTrade will continue to be tracked, provided they are still
“in-trade” on the Vote Line when it is turned back ON.
If AutoTrade is turned OFF, the existing trade plans for each security will continue to
manage your positions, but only if you continue to manually run your ToDo List
regularly.

Adaptive Trade Management User Guide
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Paper vs. Live Brokerage
Make your brokerage selection using the broker drop down toolbar.

Figure 3-7. Broker Toolbar Showing the Paper Broker Selected

If brokerage has been activated (i.e., a live connection to the broker is established)
then orders will be sent to the broker instead. This is indicated in the Broker tool bar.
See the OmniTrader Help to learn how to establish a connection with a supported
broker. It is recommended that a user run in Paper for at least a few days to a week to
gain familiarity with the software before activating for live trading.

Inportant Notes about AutoTrade
1. Orders Blocks cannot be auto-traded. Strategies used with AutoTrade MUST
have a Trade Plan. If it has an Orders Block instead, OmniTrader will use the
Default Trade Plan (as shown under Edit Trade Plans). Open any Strategy with an
Orders Block in Strategy Builder and add a Trade Plan that is equivalent to the
Orders Block. See the OmniTrader Help file on how to configure Trade Plans.
(See instructions at the end of this chapter for downloading and installing
RTM7a)
2. Cannot mix Market on Open and Market on Close Orders. Because
AutoTrade submits orders at one time, it is not possible to have different
Strategies with Market on Close and Market on Open orders. This is a peculiarity
of how brokers accept orders. If a Market on Close order is submitted before the
Open, it will be rejected. If a Market on Open order is submitted during the trading
day, that will also be rejected.
The solution to this conflict is simple: If your Order Submission time is prior to
the Open, all Trade Plans must have a Market or Market on Open order type. If
your Order Submission time is during the session, all Trade Plans must have a
Market or Market on Close order type.
3. Automatic Runs of the Portfolio Simulator from the ToDo List.
© Nirvana Systems Inc.
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OmniTrader runs the Portfolio Simulator when “Run Portfolio Simulator” is
checked (see below). AutoTrade automatically checks this box.
If the Method you are using has optimization turned on, it will be optimized each
day. Most users turn Optimization OFF once they have configured a Method for
use. The Universal Method has all Optimization turned OFF.

Figure 3-8. Run Portfolio Simulation Enabled in the To Do List

4. Email Notifications
Our server will send email notifications when orders are placed, if there is an error in
OmniTrader, OR if the server detects that an AutoTrade process has stopped.

Figure 3-9. An Email is Sent if an Interruption to Trading is Detected

Adaptive Trade Management User Guide
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Instructions for Using RTM7a
Strategies used in ATM must have Trade Plans rather than Orders Blocks. In The
Universal Method, we used one Strategy that has an Order Block – RTM7. We have
created a copy of this Strategy with a Trade Plan that you can download and use
instead:
1. Click this link: http://downloads.nirvanasystems.com/OT/RTM7a.ots It should
automatically download the file in your browser (lower left corner in Google
Chrome).
2. Right Click and select “Show in Folder”.
3. Drag it from the Downloads folder to your OT2018/Strategies folder (or,
copy/paste it from there to your OT2018/Strategies folder.)
4. Run OmniTrader.
5. Activate RTM7a and disable RTM7 in your Strategy List.
6. Activate the ATM interface.
7. Open the Universal Trading Method and go to the Strategies tab for the Bear
Market State. Remove the enable check from RTM7 and check RTM7a.
8. Repeat Step 5. for the Default Market State.

© Nirvana Systems Inc.
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Comparing ATM Methods

Using ATMS and the Portfolio Simulator, ATMS methods can easily be compared
against each other. In this ATM Methods selection, we have activated % of Equity,
Reversal, and Universal.
When the Simulation runs, it will produce a separate result for each method. These
can easily be compared in the Portfolio Simulator interface, as shown below.

Figure 4-1. Three Methods Selected in ATM

© Nirvana Systems Inc.
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Figure 4-2. Equity Curve Comparison in Portfolio

This ATMS run shows the difference between % of Equity, Reversal (an ATS Ranking
Method) and the Universal Trading method. The considerable advantage of using
ATMS is very clear in this comparison.

The Universal Method
The included Universal Method demonstrates three Market States, each of which uses
Ranking and Trade Allocation. In this section we will look at specifics of how
Universal is defined and ways you might want to customize it.

Market States
Three Market States are defined:
1. “Raging Bull”—Volatility Price Ratio of SPY at a very low value (<0.007).
2. “Bearish”—The SPY ETF is below its 200 period Moving Average
3. “Bullish (default)”—Neither of the above.

© Nirvana Systems Inc.
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Figure 4-3. The ATM Methods will Show the Market States used in Universal

Strategies
For the Universal Method example, we activated 7 popular Strategies.

Figure 4-4. Strategies Enabled in the Universal Method

Do you need precisely these Strategies?
One of the most common questions we get is, “What if I don’t have all these
Strategies?” The obvious answer is you can call us and we will upgrade you at a
reasonable cost to acquire them. HOWEVER, there is nothing special about the ones

Adaptive Trade Management User Guide
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we used, except that three of them are short term, “Reversion to Mean” Strategies and
some are longer term “Trend Following” Strategies.
Nirvana has released many Strategies over the years. XLS-19, T3 and the X-Suite are
just a few really good Reversion to Mean Strategies. Position Trader and Guppy are
some great Trend Following strategies. In the weeks after release to Beta Testers,
several users doubled and tripled our published results by using other Strategies as
published in the OmniVest Forum.
Before purchasing more Strategies, we suggest you activate the ones you have
according to the following scheme.
.

Changing Strategies
The Universal Method can be examined by double-clicking the method in the ATM
list. To change the Strategies being used, click the Strategies tab.

© Nirvana Systems Inc.
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Figure 4-5. Strategies Tab in ATM

In the above screen capture, the Raging Bull Market State is selected. You will see
these Strategies if you have them in your OmniTrader. If you don’t have them, you
will see all the ones you have activated in your profile, but they will not be checked.
Simply click [x] under “Use” for each one you want to run.
• Raging Bull Market State – Use “Trend Following” Strategies.
• Bearish Market State – Use “Reversion to Mean” Strategies.
• Default (Bullish) Market State – Use “Reversion to Mean” Strategies.

Using Your Own Strategies
Activate your Strategies in OmniTrader by selecting them in the Strategies tab of the
ToDo List. Here are classifications of many of our Strategies to help you in this
decision: For the Default (Bullish) Market State, you will want Reversion to Mean
Strategies (see previous page for categories).
In case you don’t know the classifications of your strategies, here are some
categories:

Adaptive Trade Management User Guide
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.

Now, go to the Strategy tab and check all those you will want to use in a given Market
State.

© Nirvana Systems Inc.
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Figure 4-6. Strategies Selected for a Market State

Optimizing Strategy Selection
You can let ATM determine which Strategies work the best together by using Strategy
Selection optimization. After selecting all potential Strategies for a Market State,
click the Optimize Selection box.

Figure 4-7. Optimize Selection Box

Save the ATM Method and click Run Analysis. Depending on how many Strategies
you have active, optimization can take a long time.
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Est: 2N * Average Run Time;
So, if you have 8 Strategies and one run takes 10 seconds, that will be 28 runs * 10
sec = 256 * 10 = 2,560 seconds = about ¾ hour.

Figure 4-8. Strategies Selected During Optimization

Copy the Strategies that were selected to the same Market State Strategies tab by
checking the correct boxes in that tab.

© Nirvana Systems Inc.
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Working with ATM
In the above section, “Using ATMS” we show how to use the feature for trading,
including customizing the Strategy Selection list, which most users will want to do.
However, many users will want to go beyond simply using the software to implement
their own Filtering, Ranking, Allocation and Market State ideas. You may also want
to OPTIMIZE values in ATMS in order to fine tune indicators, allocation values or
long/short balancing within Market States. In this section, we will discuss how to do
that.

Market State
Market States were discussed with respect to the Universal Trading Method example.
Users can easily change the ones we provide or add their own.
The Market State is shown in the first tab in the ATM interface:

Figure 4-9. Medthod Editor

The Market States are evaluated in the order they appear. The first one that is TRUE
is applied to the given bar in the charts. In this example, if VTY_PRICE(30,10) is less
than 0.007, then all tabs in this Market State will be used to establish Filtering,
Ranking, Allocation and the Strategies applied.
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Example of Optimizing a Market State Formula
In this section, we will optimize the Indicator formula for the Raging Bull Market
State. To do this, we will establish multiple variables in the Indicator Formula, and
define an optimization range for each.
1. Change the Formula to use optimizing variables
In this example, we might want to try the following: VTY_PRICE(OPT1, OPT2),
where OPT1 can be 10-50 in increments of 10 and OPT2 can be 5-20 in increments
of 5.
2. Add an Optimization Variable
Click “Add” on the right side and type “OPT1” in the box.

Now, change the values for Min, Max, Increment to 10,50,10 with Default 30.Check
the box under the Opt column.

3. Add the 2nd Optimization Variable
Add OPT2 the same way, and set Min, Max, and Incr at 5,20,5 with Default set to 10.
4.) Set Optimization Goal
The Optimization Goal specifies how the optimization determines the best answer.
This setting is in the Simulation Constraints tab, which is general to ALL Methods.

© Nirvana Systems Inc.
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5.) Run the Optimization
Now, click Run Analysis on the left side of the Portfolio Simulator interface.
As the optimization runs, you will see the parameters displayed at the bottom as each
run progresses. On the FIRST run, the Portfolio Simulator must collect all the trades
from the database, but on subsequent runs, it will be much faster because the trade
data is cached.

When the optimization finishes, the Best Answer will be used in the Simulation and
resulting Equity Curve and Statistics, and can be copied to the ATMS Method (Step
7 below).
6.) Review the Results
In our run, doing the above resulted in about a 3% improvement in final equity, from
$73m to $75m.
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.

7.) Setting the Defaults based on the Optimization
Since we like the results, we want to make the new optimized values the “Defaults”

Figure 4-10. Optimization Parameters in the Portfolio Simulation

© Nirvana Systems Inc.
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When you optimize any parameters in ATM, you must copy the values
to the ATM interface if you want to use them in subsequent runs.

Note

Optimized values can be found in the OptVal column on the Market State tab, in the
Portfolio Simulation grid and in the PortSim statistics. Simply copy the values to the
Default column for the Optimization variables you established, as shown.

Trade Filtering
Filters are applied to any Symbol to be traded in a Market State, to only allow those
with certain conditions. Here is the Filter tab with a new Filter added that is called
Low Volatility.

Figure 4-11. Trade Filter Added to the Universal Method

Follow these instructions to add a filter:
1. Click Add in the Filter List; Enter the Name of the Filter (Low Volatility in the
above example)
2. 2. Fill in the formulas for Long and Short. In the above example, the formula used
is: VTY_PRICE(30,10) < .01
The Filter Formulas can also be optimized. (see Example: Optimizing Market States
above.)
Adaptive Trade Management User Guide
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Trade Ranking
ATM can use multiple indicators for ranking. Here is an example, where
VTY_PRICE and TRII indicators are used to indicate that one trade is better (more
likely to succeed) than the other.

Figure 4-12. Example of Multiple Indicators Used in Ranking

The indicator values in CERN are lower than PYPL. If the indicator values are
predictive, we can use this to select PYPL over CERN.

How Ranking Works
ATM COMBINES Indicator Formulas to create a single value. In the example we are
discussing, the formulas are:
F1 = VTY_PRICE(14.5) F2 = TRII(60,40)
A Score is based on weighted values of the indicators using different weights.
Score = w1*F1 + w2*F2

© Nirvana Systems Inc.
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The ranking score also gets normalized to provide 0 to 100 ranged
values.
Note

We can let ATS “optimize” w1 and w2 to find values that maximize Ending Equity
(see Optimizing Trade Ranking Weights, below). In this case, the values 90 and 30
were found. We use these values to calculate the Score, as shown below the chart of
PYPL.

Figure 4-13. Trade Ranking Example

Optimizing Trade Ranking Weights
The Trade Ranking tab has TWO SEPARATE Optimization functions – one for
Weights and another for Formula Parameters.
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The Min, Max and Inc fields are separately available for both Ranking Weights and
Formula Optimization (See Optimizing Market States, above)

Allocation
The Allocation tab is used for two functions:
1. Establish individual trade allocation method (like % of Equity or Fixed Trade
Size).
2. Establish market balance (Longs vs. Shorts).

Figure 4-14. The ATM Allocation Tab

© Nirvana Systems Inc.
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The Trade Allocation selection drop down allows you to select one of our standard
PortSim methods, like % of Equity, Kelly Criteria, and many others. When you select
a method, the parameters will be displayed below it, which can be optimized.
The Trade Limits and Market Balancing establishes Max Longs and Max Shorts
(trades). Max Long% and Min Long% automatically establish the value of Max Short
%, since it will be the inverse of the Max Long%. That is, if Max Long% is 80 than
Max Short% is 100-80 = 20%.

ATM Method Development
Many of our users have used technical trading concepts for many years, and have
accumulated experience with indicators such as Bollinger Bands, Stochastics, and
other indicators. This experience can provide valuable insights into the best way to
perform Ranking and Filtering. Fortunately, if you are generally familiar with how
OmniTrader Strategies work, it’s easy to use indicators to create new ATM Methods
or to add Market States within a defined Method.
In the sample ATM profile, we used the S&P 100 and Nasdaq 100 stocks. It’s
important to recognize that OmniScans can be used to select symbols each day. Once
a Trade Filter has been identified that improves results in the primary Market State,
the formula for the Trade Filter can be used to create a new OmniScan, allowing the
entire market to be scanned for those opportunities.
In addition, custom indicators can be developed for Ranking, Filtering or Market
States. Market States can be defined for different index symbols within the same
method. We have only scratched the surface of what can be done with ATM and look
forward to seeing how our users profit from it.

Ideas for Furthering the ATM Concept
Nirvana Club (ARM) Strategies
AI Rules produces superior Strategies. We have not yet tested ARMx Strategies with
ATM. But we expect results with these Strategies to be better than the early method
released with the platform.
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Using NN and GA Indicators for Filtering and Ranking
In 2015 and 2016, indicators for the Neural Network and Genetic Algorithm were
released in the The Nirvana Club. We expect these indicators to assist with both Trade
Filtering and Trade Ranking.

Advanced Allocation Methods using the SDK
For those familiar with the Microsoft Dot Net programming environment, the
OmniTrader Strategy Development Kit (SDK) has the ability to develop custom
allocation methods.
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Introduction

The previous Chapters have dealt with Configuring ATM by manually defining
Market States for the software to run on. As we have seen, ATM can switch between
Market States, selecting different Filters and Rankers, and enabling different
Strategies in each State. It’s a very powerful concept. The problem, of course, is
figuring out how to construct these States – a process that is worth the effort but is
also somewhat time consuming, requiring a lot of trial and error.

What if ATM could configure itself as it trades?
What if we supplied a reasonable set of Market States and Strategies, with a good (but
not perfect) Symbol List, and let ATM determine which ones to use through some
kind of automated process. That is precisely what was done in the development of
ATM version 3.
ATM v3 (or “ATM3” for short) was designed to use historical data to test all the
internal assets, in order to discover which combinations have been the most
CONSISTENTLY profitable over a long period of time. It can do this for every
combination of Symbol+Strategy as well as Market State+Strategy.
To visualize this, let’s say stock AAPL was tested (or “paired”) with our RTM7
Strategy. We observe that it has performed consistently and made steady gains over
the past 3 years. The theory is that this combination (AAPL + RTM7) is more likely
to perform well in the next time period than some other Symbol+Strategy pair that
has performed poorly in recent years.
This research was initiated by Nirvana Club Member Mark Holstius at the end of
2018. Using Excel spreadsheets, Mark demonstrated that if you ONLY took trades
from Symbol+Strategy pairs that have worked well in the past, you are much more
likely to achieve profitability in the next “increment” of time, which would typically
© Nirvana Systems Inc.
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be a month or a calendar quarter. The idea was to then re-run the analysis for the next
increment and “rank” the pairs at that point in time to determine which ones should
be traded - if they generated a Signal in the next increment of time.
Nirvana worked with Mark on this theory, applying the basic formula Mark derived
to achieve the scoring of pairs. The work began in January 2018 and was finalized
in January 2020 – a year later. Needless to say, this was a MAJOR software effort for
Nirvana’s development staff The result is ATM v3, which was called “ATM3” in the
release literature. We will just call it ATM from this point forward.

A “Technical Analysis Dynamo!”
With the V3 enhancements, ATM became a Technical Analysis Dynamo, applying
the best of all worlds where historical data analysis is concerned. It essentially breaks
the problem into two parts – the Back Test, where all optimizations occur, and a
Forward Test, where the formula is applied in successive time increments in “Walk
Forward” fashion, using the analysis from the immediate past to rank the Symbol +
Strategy pairs for consideration in the next interval.
In this way, ATM is able to (a) Find good default values for all the parameters that can
be optimized in an ATM Method (Filters, Rankers, Strategies, and Allocation), and
(b) progressively identify those combinations of Strategies, Symbols, and Market
States that have the highest likelihood for success in the Forward Test and of course,
in real trading.
Our goal in this chapter is to thoroughly explain WHAT ATM is doing when
“Automation” is activated. Since its goal is to automate these processes, that’s really
all you need to know to effectively use it. It truly is a “Push the Button” automation
product!

How ATM Automation Works
In this section we will explain exactly what happens when Automation is activated.
Once that is understood, we will explain the few “knobs” that drive it.
ATM Automation involves a two step process.
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Step 1: The “Classic” ATM process
Simulations are run as described in Chapter 4, to discover theF best optimization
parameters, if they have been defined in the method.

•
•
•
•
•

Market State
Filters
Rankers
Strategies
Allocation

These simulations use PortSim Simulation Constraints to determine the best values.They are
run on the Back Test ONLY, which is an improvement over the original version of ATM.
The idea of Part 1 is to find good default values for each Market State, using the data in the
Back Test. With this approach, we can have general ranges for things like Filter Parameters
and let ATM find those that worked over a long period of time, to establish them as defaults.

Step 2: The Walk Forward Analysis
The Forward Test is used for Walk Forward simulation based on time intervals, which
are typically months but can be quarters. The idea of Step 2 is to look backward from
the current time interval and Score each combination of Market State, Strategy and
Symbol to find those that generated the most robust and “smoothest” simulations.
That is, we prefer to trade something that has shown a steady ability to make money
over time, with low draw downs and steady gains.
This Walk Forward Analysis is run on one of the following as specified in Settings:
a. Symbol – Strategy pairs
b. Market State – Strategy pairs
c. A Combination of a) and b) - the “intersection” of the two.
The Scoring formula, which will be described in the section on Scoring, is used to
generate a Score at each interval, which can then be used to sort the pairs. The highest
Scoring pairs are the ones that can be traded in the next increment – provided they fire
a Signal.
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Here is a picture of this process:

In this picture, we have 3 increments in the Forward Test. Typical Forward Tests will
be defined as spanning 2-4 years with monthly increments, which would be 48 or
more. But the illustration suffices to make the point, which is that for each increment,
a simulation is performed on Market States, Strategies and Symbols to rank them by
Score for use in the interval.

Scoring the Pairs
Pairs are scored on one of several metrics, as defined in Settings, below.

•
•
•
•
•
•

CAR – Compound annual rate of return
APR – Annual percentage return rate
Consistency – Consistency of profits from period to period
Stability – Return to Draw Down Ratio as small as possible
Mark I – One Period Scoring
Mark II – Two Period Scoring

These options for Scoring can be selected in Settings (next section).
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Mark I vs. Mark II
Mark I scores a simulation (either Strategy+Symbol or Strategy+Market State) based
on the “smoothness” of the equity curve.

Mark II has a reserved area that is combined with the primary area. The idea of this
scoring technique is that it looks at the most recent performance to determine if the
simulation is holding up well in the most recent data.
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The selection of which Scoring Metric to use is made in Automation Settings.
A few experiments selecting the different Scoring Methods will help you decide
which ones are best for your application (i.e., your Symbol List and Strategies).

Automation Settings
In this section, we will cover the Automation Settings that drive ATM Automation. From the
ATM Method dialog, click Settings to reach them.

.
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When you click Settings, go to the Automation tab.
Here is a description of each Setting:
• Enable Automation—This enables the entire Walk-Forward process that uses
Equity Curve scoring. Without this checked, ATM will behave as it has in
versions prior to v3. When you enable Automation, you enable a process which
uses the OmniTrader Forward Test (as defined in the ToDo List) to determine the
best Symbol-Strategy, Market State – Strategy, or a combination for selecting
trades for the Walk Forward process at each incremental time period in the
Forward Test. We will expand on these below.
Optimize For:
• Symbol – Strategy—With this selection, EVERY Symbol and Strategy
combination is tested using a SUPER FAST Portolio Simulation, to determine
which pairs have the most “robust” performance, i.e, strong profitability up to the
current interval, indicating a strong chance for continued profitable behavior.
– Using the top [100] %—This setting tells ATM to use the pairs that are in the
top X% of results. 100% as shown here is a neutral setting because it will
select all of them. If you want to be selective, set this to the top 50% or to be
more restrictive, the top 30%,, etc. A few quick runs in ATM with your List
and Strategies will show you the best setting.
• Market State – Strategy—This setting is truly revolutionary. It essentially tests
each Market State with each Strategy, and scores the outcome.
– Using the top [100%]—Same comment as above. This will select ALL pairs.
Reduce the number to be more selective.
• Both—This is perhaps the most powerful setting. It:
– Finds the top N% Symbol - Strategy Pairs
– Finds the top M% Market State – Strategy Pairs
– ONLY trades Symbols and Strategies that appear in BOTH lists.
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Performance Statistics to Use
There are several different algorithms that “Score” the Strategy – Symbol or Market
State – Strategy pairs.

•
•
•

•

•
•

•

CAR—Compound annual rate of return. This is a simple return measurement.
HR—Accuracy of trades. A Hit Rate of 80 means 80% of the trades were
profitable.
Consistency—Consistency of profits from period to period. Months are typically
used. This metric measures the performance month to month and calculates a
Standard Deviation of return between these periods. The smaller the StDev, the
higher the score.
Stability—Return to Draw Down Ratio as small as possible. This statistic looks
over the entire period of time and seeks to reduce the Return to Drawdown ratio
as much as possible to establish high scores for the most consistently profitable
equity curves.
Smooth—This algorithm is similar to Mark I (described next) in that it attempts
to score the equity curves that are the “smoothest” with the highest ratings.
Mark I – One Period Scoring—This algorithm, by Mark Holstius, evaluates the
Score of trade in a Back Test period by considering the number of trades, Hit Rate
and Profit per Trade. Higher scores show pairs that have produced exceptionally
smooth equity curves over their entire test period.
Mark II – Two Period Scoring—In this unique algorithm, also by Mark, two
periods are defined – an internal Back Test and an internal Forward Test. The
idea is that the scores of the two periods are merged so that the equity curves with
the highest scores are those that performed well in BOTH periods. This algorithm
typically beats the others (depending on Strategies, etc., used).
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Increment Period—This is the increment in the Walk Forward Test. It is
typically Monthly but can also be Quarterly.
Analysis Bars—When Scoring is done for the next interval, a certain number of
bars is used immediately ahead of the interval. This setting determines how many
bars are used, which can be a specific number (500 is the default) or All Data,
which is all data loaded up to the start of the interval.
Only Use a Strategy Once per Interval—If you are using Concurrent Market
States, which means any Market State can fire if its conditions are true, it is
possible for a Strategy to be active in more than one Market State, which can lead
to over-trading a given Strategy. This setting limits Strategy usage to one per
Market State per interval.
Blend Allocations between Concurrent Market States—Concurrent Market
States can create a problem where trades from different Market States fire at the
same time. The Allocation Rules are specific to each Market State. So, let’s say
3 different States fire trades at the same time, with 10% allocation per trade in
each Market State. This could lead to over-allocation. This option divides the
allocation by the number of Market States firing, in this case 3. This tends to
smooth out allocation so that the program is more normally allocated.
– Blend Factor: [1.00]—If your overall allocation seems to low with Blend
activated, increase this number to increase the total allocation per trade. It is
a multiplier.
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Included with ATM3: The ATM Auto Trend Method
ATM3 includes the ATM Auto Trend Method. This method uses a combination of
nine Market States and seven strategies in order to find the best Market
State/Strategy/Symbol combinations in the current market.

This equity curve shows the Forward Test result of the ATM Auto Trend Method. The
method uses a lookback of 160 bars (about 8 months) in order to determine the top
combinations and uses those for trading for the next calendar month.
Our testing shows that the Forward Test period generates an average annual return of
over 28% while keeping average annual drawdowns at a very low 8%. The ATM Auto
Trend Method is an excellent example of the power of ATM3’s technology.
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ATM3 Profile
ATM3 includes the ATM Auto Trend Profile that is pre-configured to automatically
run the ATM Auto Trend Method.

ATM3 Strategy
ATM3 includes a strategy called ATM3 LT Trend. This a long term, long only
strategy that is used in order to generate the results shown for the ATM Auto Trend
Method.
Signals from this strategy are initially generated by the Bollinger Band Crossover
System (BOL-C). The signals from the system must pass three filters in order to get
passed to the strategy level. Once an entry signal is generated, the ATM3 LT Trade
Plan will the manage the trade to completion.

Summary
By establishing performance metrics for the ATM Automated Walk Forward Test, dramatic
improvements in performance in Out of Sample data can be realized. We provide these
“knobs” in ATM Automation because different “problems” (combination of Symbol Lists,
Strategies, Market States) will dictate different settings for optimal results.
The good news is, the defaults provided work great. And, we are finding that the selection
of setting is sufficiently limited that anyone can run a few tests and quickly determine what
is best for them.

It’s all about the Right Edge.
ATM is designed to deliver in “The Zone” where trades are made. The unique scoring
algorithm will provide the best possible information on which Strategies + Symbols and/or
which Strategies + Market State provide the highest probability of success – on the Right
Edge. Nothing else matters.
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Over the years, Nirvana Systems has created several products that are designed to
either filter trade or change the trade mix based on market conditions.

Filters in Strategies
The first trade management feature introduced in OmniTrader was filters in
Strategies. A Filter in the Strategy flowchart enables a Strategy to withhold signals
If certain market conditions are not present. This feature was added to Omni Trader
around 2000.

Figure 6-1. The Filter Block can be used to keep a Strategy from Trading in Certain Conditions

Over the years, Nirvana Systems has created several products that are designed to
either filter trade or change the trade mix based on market conditions.

Dynamic Signal Selection (DSS)
In 2013 a new product was developed by Nirvana Systems to apply this concept to
multiple strategies at the same time. In this case, a new concept – “Market State” was
introduced. A single formula was applied to an Index to allow Signals in the Focus
List to generate trades only if the condition is met (such as S&P 500 above a moving
average). This new feature would apply to ALL Signals, not just those in certain
Strategies. Ranking of Signals based on a single indicator was also added. Finally,
allocation to Longs vs. Shorts could be defined for any Market State.
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Figure 6-2. Dynamic Signal Selection Runs in the To Do List

This feature was released with OmniTrader 2014. It definitely improves the
profitability of OmniTrader when properly configured, but the user is required to run
the Focus List each time a new configuration is to be tested.
So, it was impractical to try many variations of the indicators. For this reason,
advances in the Market State concept were slow to be realized with the product.

Automatic Trade Selection (ATS)
In 2017, Nirvana developed in a new way to Rank Signals in the Focus List. Rather
than perform this task in the ToDo List, which means all Symbols must be run across
the time period selected, the Portfolio Simulator was used instead. This was a major
breakthrough because the Portfolio Simulator operates off pre-calculated historical
trades, and thus can run thousands of times faster than DSS.
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Figure 6-3. Automatic Trade Selection is the pre-cursor to ATM, supporting Ranking and Allocation.

Adaptive Trade Management System (ATM)
The Adaptive Trade Management System combines Strategy Selection, Trade
Ranking, Trade Filtering, Allocation and Long/Short Balancing under Market States.
In addition, the parameters for any part of ATM can be optimized.
.

Figure 6-4. Comparison of Approaches to Trade Management

Nirvana Systems thanks you for using ATM. Best of luck in our trading.
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